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Authorized Users 
Access to LINIIS (Labor and Industries Insurance System) vocational referral information is 

available for registered Vocational Rehabilitation Counselors (VRCs) and Firm Designees through 

VocLink.  

Provider registration forms are available at: 
http://www.lni.wa.gov/ClaimsIns/Voc/WorkWithLni/Provider/Default.asp   

 

 

Access to VocLink is obtained through Host on Demand (HOD) via Secure Access Washington at 

https://secureaccess.wa.gov/.  

Host On-Demand (HOD) System Requirements 
HOD is an Internet-to-host connectivity tool that enables secure browser access to host applications. 

HOD runs as a Java applet in a web browser. 

 

If you will be using HOD from a remote network located behind a firewall, make sure your 

firewall administrator opens port 3272. 

 

The HOD client connects back to the telnet server (available through secureaccess.wa.gov) on 

this port and will fail to establish a connection if the port is not open. 

 
The following is a list of necessary software to use the Host On Demand client version 11.  

http://www.lni.wa.gov/ClaimsIns/Voc/WorkWithLni/Provider/Default.asp
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Compatible Operating Systems: 
Compatible 

Browsers: 

Compatible Java 

Versions: 

Macintosh  

 Mac OS X 10.2.1  

 Mac OS X 10.3  

 Mac OS X 10.4  

Windows  

 Windows 2000 (Professional and Advanced) 

Server  

 Windows XP Professional Edition  

 Windows XP Home Edition (32-bit version)  

 Windows Server 2003 (Enterprise, Standard, and 

Web)  

 Windows Server 2003 R2 (Standard and 

Enterprise Editions)  

 Windows Vista (Business, Enterprise, and 

Ultimate Editions)  

 Windows Fundamentals for Legacy PC IPV6  

 Windows Terminal Services for Windows 2003  

 Windows Server 2008 (Standard and Enterprise 

Editions)  

 Windows 2008 R2 (Standard and Enterprise 

Editions - only 64-bit)  

 Windows 7 (Professional, Enterprise and 

Ultimate Editions)  

Internet Explorer  

 Version 6.0  

 Version 7.0  

 Version 8.0  

Firefox  

 Version 1.5  

 Version 2.0  

 Version 3.0  

 Version 3.5  

Safari  

 Version 1.0  

 Version 2.0  

 Version 3.2.2  

Sun Java plug-ins  

 Version 1.5.0  

 Version 1.6.0  

 Results Can Vary:  
 Version 1.7.0  

 

Java Virtual Machine (JVM) requirements for HOD 
To check your Microsoft Internet Explorer JVM level, select Tools => Internet Options => Advanced 

=> scroll down to “Microsoft VM” and check “Java console enabled”. You must then restart your 

computer and/or browser. Go back into IE and select View => Java Console. You should see 

something like: 
 

Microsoft (R) VM for Java, 5.0 Release 5.0.0.3309 

==============================================   
? help  

c clear  

f run finalizers  

g garbage collect  

m memory usage  

q quit  

t thread list 

==============================================  
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The JVM level is listed in the release number. In this example the release number is 5.0.0.3309. The 

JVM level is 3309. Once Labor and Industries has approved your on-line application, you will 

receive an e-mail providing you with a temporary password. You may then access LINIIS through 

the VocLink process. 

 
Secure Access Washington 
Access to VocLink is provided through Secure Access Washington (SAW), located at 

https://secureaccess.wa.gov   

 

After creating a new account or logging into your SAW account, click on Add a New Service and 

enter LNI_VOCLINK as your service code, fill out the online registration form, and request 

access. -Voc Link Connect will display on the My Services page in SAW with the user status 

shown as pending. 

 

Labor and Industries will review your application. If all of the information provided is correct, your 

application will be approved. 

 

You will receive an email notifying you that your application has been accepted, and a separate        

email containing your temporary VocLink password. Please see Password Requirements on  

page 5 for more information. 

 

SAW’s My Services page will now display the service Voc Link Connect as active. 

 
Downloading Host On-Demand (HOD) 
Click on Voc Link Connect from your My Services page in SAW. 

 

The CTS Home page will display. Click on HOD Client, and follow the instructions to download 

the cached client. 

 

HOD will detect the level of Java support on your system.   If your Java version is not sufficient, you 

will be prompted to download the Java plugin from the HOD server. 

 

After you have downloaded Java for the first time, you will need to close and reopen your browser. 

Return to the My Services page within SAW and select the Voc Link Connect service.  

 

Click on the HOD Client button from the CTS Home page. The IBM Rational  Host on Demand 

page displays with the 3270 DIS S/390  icon . 

 

If a Security Warning window appears asking if you want to install and run IBM Host On Demand, 

click on Yes. 

 

The terminal screen box labeled ”DIS S/390 – A – NTV110F9” will display the TPX login screen. 

 
Logging into LINIIS 
At the TPX login screen, key your Userid (i.e. PXXX235) and Tab to the Password field. 

 

Key your password and press Enter to display the TPX MENU. 

https://secureaccess.wa.gov/
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Press PF4 to access LINIIS. On the CICS ENVIRONMENT screen, key your Userid, tab to the 

Password field, key your password and press Enter. 

 

A screen will display with SIGN ON COMPLETE in the upper left hand corner. Key LVOC in the 

upper left hand corner and press Enter. 

 

The MULTI REGION OPTION (MRO) ROUTING SCREEN displays. Press Enter. 

 

If you are only a Voc Counselor, or only a Voc Firm Representative, the VMEN screen will display. 

 

If you are both a Voc Counselor and a Voc Firm Representative, a screen will display asking you 

which function you wish to access. Key an X on the blank line next to the desired function and press 

Enter to display the VMEN screen. 

 

NOTE: If you are a first time user, or you have had your password reset, key your temporary 

password in the Password field. Your cursor will automatically move to the New Password field. 

Press Enter. The system will display a message that your password has expired. Key a new password 

in the New Password field and press Enter. The system will ask you to re-Enter your password for 

verification. Re-key your password and press Enter to continue logging into VocLink. 

 

Please see Password Requirements on page 5 for more information. 

 
Logging Out of the System 
To log out of LINIIS, press F12 from any LINIIS screen. The TPX MENU screen displays. 

 

Key /K on the Command line. The TPX login screen displays. 

 

To close the DIS S/390 window, either click the X in the upper right hand corner of the screen, or 

click Exit in the upper left hand corner of the screen. 

 

The IBM Rational  Host On-Demand page displays in the Internet browser window. 

 

You may now close your browser, access another Internet site, or re-enter VocLink by clicking on 

the 3270 DIS S/390 icon.   

 
Password Requirements 

 Must be exactly 8 characters in length.  

 Must contain at least one symbol: @, #, or $.  

 Must contain at least one number. 

 Must NOT contain your Logon/user ID or Name. 

 Must not contain three or more consecutive characters from first, middle or last name.  

 Must be different from the previous 5 that were used. Changing the case is not acceptable.  

 Must be different by at least three characters from the old password. 

 

VocLink passwords are valid for 60 days. To change your password before it expires, at the TPX 

screen, key your Userid and tab to the Password field. Key your current password. Your cursor will 
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stop on the New Password field. Key a new password and press Enter. Re-enter your password for 

verification and press Enter to change your password. 

 

Your Userid will be revoked after three consecutive attempts to log on with the incorrect password. 

 

If your password expires or is revoked, please email LNI’s Web Customer Support at  

websupport@lni.wa.gov or call (360) 902-5999 and press option 2 for assistance.    

VocLink LINIIS Screen functionality 
Upon entering LINIIS, your cursor will default to the command line on the VMEN screen. This 

screen is a list of the LINIIS screens and procedures to which you have access. 

 

From any screen in LINIIS, key a four-letter screen name and claim number on the command line in 

the lower left hand corner and press Enter. 

 

Key a four-letter screen name without a claim number, and a prompt screen will display from which 

you may key the desired claim number. 

 

Once you access a specific claim, you can access a new screen by typing the screen name at the 

command line without re-keying the claim number. 

 

Claims are coded with the Work Position ID of the Claims Manager assigned to the claim. The 

Claims Manager’s name can be obtained by placing the cursor on the first letter of the work position 

in RLOG and clicking on the F1 key. LINIIS screen EUSE also displays Work Position ID 

information.  

 
VocLink LINIIS System Screen Menu  
VMEN----list of available LINIIS screens  

 
Voc Firm Representative Only Screens 
UVUR----Unassigned Referrals (Firm)…………………………………….6  

RVPR-----Review Open Referrals (Firm)………………………………….7  

HVPR-----Review Closed Referrals (Firm)………………………………..7 

VRC Only Screens 
UVRS-----Review/Update Open Referrals (VRC)………………………..7  

RVRS-----Review Closed Referrals (VRC)……………………………….7 

   

UVUR - Unassigned Referrals 
At the UVUR screen, key your Firm Provider and Branch IDs. Press Enter. The screen will display a 

list of all of the referrals that need to have a VRC assigned. Your cursor will default to the SEQ # 

field. Place your selection number in the field and press Enter. 

 

Key the VRC’s Service Provider ID in the ID field across from VRC NAME, and press Enter. This 

action assigns the referral. 

mailto:websupport@lni.wa.gov
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You will be transferred back to the UVUR screen where you can key the same branch number or a 

new branch number in the BRANCH ID field, and continue, or F12 to exit the system. 

RVPR - Active Referrals for a Specific Firm 
Key RVPR and press Enter. Key a FIRM PROVIDER ID, BRANCH number, and the letter 

corresponding to the type of referral you would like to review. Press Enter. You will be transferred 

to Screen 2. You will need to do this for each branch and each letter. 

 

Pick the sequence number you would like to review by placing the number in the SELECT SEQ-

NUM field, and press Enter. You can now review the referral information.  

 

Press Enter from this screen to transfer back to the list. You can view another sequence number to 

view, or press F10 to go back to the screen where you entered your firm and branch and pick a 

different type of referral to view, or F12 to exit the system.  

HVPR - Review closed referrals for firm/branch 
The firm has the ability to go to this referral history screen and view all of the closed referrals by 

branch number and referral type. Key your firm and branch numbers, and the letter corresponding to 

the type of referral you want to review. Press Enter to view the referrals. 

 

You can now review your list of closed referrals. Use the SELECT SEQ_NUM field at the bottom 

of the screen to request detail on a specific referral. 

 

HVPR - Screen 3 - Review a plan Development Referral 
On screen three, you can see the recommended outcome made by the VRC. You can also view the 

actual outcome entered by the claims manager. 

 

From this screen, press Enter to return to the sequence number list of referrals. Press F10 to return to 

the screen where you can key firm and branch and type of referral to view more closed referrals.  

Press F12 to exit the system.  

UVRS - Select Referrals for a Specific VRC (Update/Review Referrals) 
(Note: If you have both the Voc Counselor and Firm Representative roles, you may access 

UVRS while logged on as the Firm Representative but  will not have update capability. To 

update UVRS, you will need to logon in the Voc Couselor role.) 
Key UVRS in the command line in the lower left hand corner and press Enter. Key your service 

provider ID number. Press Enter again to bring up your referral list. 

 

The second screen will display a list of all open referrals to a VRC. Key a number in SELECT SEQ-

NUMBER to make your vocational recommendation. Press Enter to go to the next screen. 

 

At the update screen, key a ? in the recommended outcome field and press Enter. This will bring up 

a list of possible outcomes for the type of referral selected. There are several pages to this list. Press 

Enter until you find the desired outcome. Place the cursor on the selected outcome on the list and 



7 | P a g e  

 

press Enter. It will enter it on the screen for you. Click on Enter to update the referral. When the 

referral has been updated, you will be returned to the first screen that lists all your referrals (UVRS). 

If the screen did not return, the referral was not updated. 

 

You are able to change the outcome code and dates until the claim manager closes the referral. The 

referral will remain on your referral screen until the claim manager closes the referral. 

 
Changing your recommendation: 
To change an outcome code or date, re-enter the screen, delete both the outcome code and the date. 

Press Enter, then; re-key the referral and the new outcome or date. 

 

If you have made a mistake, or do not wish to update this referral, you may press F10 to return to 

your referral list to make another update. The F12 key will allow you to exit the system. 

 

RVRS - Select Referral for a Specific VRC (Review of Closed Referrals) 

The screen will display closed referrals for a specific VRC. Key your VRC Provider ID in the 

displayed field and press Enter. 

 

The second screen is a display list of closed referrals for a VRC. Key the sequence number of the 

referral information you wish to view. Press Enter to view detail. 

 

The F10 key will take you back to screen 1 to re-key your VRC provider number. The F12 key will 

allow you to exit the system.  

 
Recommended Outcomes 
This is the list of the outcomes that are available to you based on the type of referral you are 

working. This list will “pop up” when you key a “?” in the outcome field when you are making a 

recommendation on your referral. The list of outcome codes can be accessed by the following 

link: 

 http://www.lni.wa.gov/ClaimsIns/Voc/WorkWithLni/OutcomeList/Default.asp  

Contacts for Help with VocLink 
 

For help with your status as a VRC or Voc Firm Representative 
Department of Labor and Industries 

Private Sector Rehabilitation Services 

P.O. Box 44326 

Olympia, WA 98504-4326 

(360) 902-6756  

 

For help with access to VocLink  
Department of Labor and Industries 

Web Customer Support Unit 

P.O. Box 44100 

http://www.lni.wa.gov/ClaimsIns/Voc/WorkWithLni/OutcomeList/Default.asp
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Olympia, WA 98504-4100 

(360) 902-5999 

vocrehab@lni.wa.gov  

For help with revoked LINIIS/VOCLINK user IDs or Passwords:  
(360) 902-5999 and press option 2 
 websupport@lni.wa.gov 

 

For help with CAC or LINIIS screens 
E mail to vocrehab@lni.wa.gov 

 

For help signing up and gaining access to VocLink through Secure Access 
Washington (SAW) 
Web Customer Support 1-360-902-5999 

 

Email websupport@Lni.wa.gov  
 
 

For any issues not related to VocLink, LINIIS or CAC please refer to the following 
vocational contact screen:   
http://www.lni.wa.gov/ClaimsIns/Voc/ContactUs/Default.asp 
 
 

 
VocLink is available from 6:00 a.m. - 6:00 p.m. Monday thru Friday except for 
state holidays. 
 
 
 
 

 
 
 
 
 
 
 
 

mailto:vocrehab@lni.wa.gov
mailto:vocrehab@lni.wa.gov
mailto:websupport@Lni.wa.gov
http://www.lni.wa.gov/ClaimsIns/Voc/ContactUs/Default.asp

